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1 Introduction 

( Note: G o  t o  Section 2.5 for a Quick Tour of major features and functions of CTGROWTH. 

1.1 BACKGROUND 

CTGROWTH was developed by Maurer Engineering Inc. under sponsorship of the joint-industry project 
DEA-67 To Develop and Evaluate Coiled-Tubing andslim-Hole Technology. This model is part of a complete 
coiled-tubing analysis suite, and will be incorporated into the integrated package CTPRO in the future. 
CTGROWTH is written in Visual Basic 5 for use with IBM-compatible computers. It runs in Microsoft 
Windows 95 or later versions. 

tubing (CT) has an unusual consideration with respect to engineering design in that it is plastically 
ed during routine usage. Each trip into a well is accompanied by three bendjstraighten cycles. CT is 

. ,  iystraightened (unbent) as it is spooled off the reel, 2) bent onto the gooseneck, 3) straightened as it comes 
" - ' .~. - '. off the gooseneck toward the injector, and then travels into the well. (Only rarely will CT be plastically 

ed while in the well.) On the trip out of the well, the three bending events are repeated in reverse order. 

After a number of trips in and out of the well (typically tens to hundreds), a string of CT will fail due to fatigue. 
- - _b___- . ,, - -.-z .:TEnumber 1 of cycles before failure is related to CT metallurgy, equipment dimensions, and other factors, and 

. can 'be predicted and tracked with the ME1 program CTLIFE. 
... 

Plastic deformation of CT can also be accompanied by diametral growth ("ballooning") whereby the OD of 
the CT increases slightly with each trip into the well. Internal pressure during bending is required for this to 
occur, and the impact is greatest at pressures greater than about 2000 psi. CT diametral growth causes 
incompatibilities with deployment equipment (the CT will not fit through the stripper bushings), and 
continuous use could cause severe mechanical damage to the CT. Accurate predictions of diametral growth 
are necessary for both safety and reliability. 

O 1998 Maurer Engineering Inc. 



Chapter I .  Introduction 

It is important to recognize that, while plastic fatigue and diametral growth are related phenomena, there is no 
direct correlation between these two failure mechanisms. Fatigue limits, diametral growth limits, or a 
combination of the two may dictate when a particular string is retired. 

Theoretical Basis 

ME1 developed CTGROWTH to meet the industry need for a reliable model for predicting CT diametral 
growth. The program was developed based on Halliburton's growth model and test data from Precision Tube 
Technology. Halliburton developed their growth model based on full-scale test data of CT generally larger 
than 2-in. OD. Precision Tube Technology measured diametral growth on a standard fatigue test fixture for 
CT smaller than 2-in. OD. For both the Halliburton and Precision Tube Technology tests, the CT was rotated 
at regular intervals as diametral growth accumulated. 

In addition, Quality Tubing's fatigue data were used as another calibration reference. CTGROWTH is related 
to MEI's CTLIFE model for estimating CT fatigue life. CTLIFE was developed based on data from Quality 

. .. " 

' . . - .~~: . . . . : : ,~~g and Halliburton. Quality Tubing recorded the growth at fatigue failure for a full series of fatigue tests. _ . &heck -,. against these data was also performed for fine-tuning CTGROWTH. 
-. - ,.," - .  

A comparison of test results and CTGROWTH predictions shows good agreement for OD growth up to 10% 
e nominal OD. A typical criterion applied in the field is to retire a string (or section of a string) when 

exceeds 6% over nominal OD. Based on these practical considerations, CTGROWTH predicts OD 
th only u p  to 10%. For predictions of growth greater than lo%, please contact MEI. 

):;," 

1 2 ~ l - E E ~ ~ ~ ~ ~ ~  OF CTGROWTH 

ROWTH 1 is a new release in the leading-edge suite of CT operations design software developed by MEI. 
"look and feel" of the program is user-friendly and intuitive. Convenient icons and tabs can be used to 
ly navigate through the program. Data-file management is simple, and options for customizing graphics 
roducing professional-style printouts are included. 

Another significant feature is a complete Help system. Descriptions and instructions are provided for every 

pJ input and output screen by clicking or pressing [FI]. The Help system is also context sensitive to allow 

intuitive navigation by pointing and clicking the mouse on the area of the screen where the user's question 
originates. Most of the information provided in the User's Manual is also contained in the Help system. 

CTGROWTH runs in the Microsoft Windows 95 and Windows NT environments. As a true 32-bit 
application, theprogram b not compatible with Windows 3.x It is assumed that the user is familiar with 
basic operation in the Windows 95 environment. For comprehensive information about Windows, the reader 
is directed to other texts. 

Important technical features of the CTGROWTH Coiled-Tubing Diametral Growth Model include: 

Calculates CT fatigue cycles with reference to a standard CT fatigue test fixture 
Calculates CT fatigue trips inlout of a well with reference to a standard wellsite rig-up 

Checks the burst pressure criterion for a given CT and warns the user if it is exceeded 
Calculates diametral growth (up to 10%) for CT cycled on a bending machine 
Calculates diametral growth (up to 10%) for CT cycled at the well site 

1-2 0 1998 Maurer  Engineer ing Inc. 



Chapter 1. Introduction 

Sensitivity analyses allow the user to evaluate the impact of changes in CT OD, wall thickness, 
material grade, internal pressure, and bending geometry on diametral growth 
Provides a choice of systems of units, including English, SI (metric), or any user-specified custom 
combination 

The Output Window provides a number of informative graphs and reports that may be printed or stored to a 
disk. 

1.3 COPYRIGHT AND DISCLAIMER 

This software and manual are copyrighted (01998) by Maurer Engineering Incorporated. The copyright 
agreement and usage restrictions are described on the Licensing window that is accessed under the Help menu 
by selecting "About ..." + "Licensing ..." (see below). By selecting [Accept] at the bottom of this screen, 
the user signifies that he agrees to abide by the restrictions as presented. No warranty or representation, 

i _ _ . . .. . . .. -=ither express or implied, is given with respect to this program and documentation, including their quality, 
we,.-. -- 

performance, merchantability, or fitness for a particular purpose. 
., ,, 

! 
#I CTGROWTH 1.0 - Version No. - COILED-TUBING DIAMETRAL GROWTH MODEL - , 
fi Dm67  

:/ Project to Develop and Evaluate toiled-Tubing and SlimHole Technology 
I/ - ;I -..- .--.. . ,, BY 

' i  Maurer Englneerlng l n r  

% 
This copyrighted 1998 confidential computcr program and manual are for the sole 
use of Panicipanis on Drilling Enginearing &ciation Project DEAS7 and their 
affiliates, and are nm to be dkdmed to other parties Data output from the 

Usage 
). -.I -. . I program may be d k e l o ~ d  tn thlrd parties Panidpants and their affiliates are Restrictions 

\ : i i' ' I  free to make copies of this program and manual fortheir inhouse use only. 1 
Maurer Engineering Inc. makes no warrany or representallon, either express I 

ii or implied, wilh r.rpectto the pmgram or documentation, including their q u a l i  Disclaimer 
/ performance. merchantablllty. or fitness for a particular purpose. 

I 
I' I International keyboard users -see Appendix A of User'r Manual. 
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2. Getting Started 

2.1 HARDWARE AND SYSTEM REOUIREMENTS 

CTGROWTH is written in Microsoft Visual Basic@ version 5. It runs in Microsoft Windows 95 or Windows 
NT (or later versions). As a 32-bit application, WELOPT is not compatible with Windows 3. The minimum 

hardware requirements are: 

IBM-compatible machine with 80486 processor 
Hard disk (about 10 megabytes of storage space required) 
Mouse 

* VGA or compatible display 

2 2  INSTALLING CTGROWTH 

pgogram Disks - 
ROWTH is shipped on two 3%-inch disks (or one CD). The CTGROWTH executable file 

ROWTH1O.EXE) should be placed in a new folder (default "C:\MEI\CTGROWTH") along with the - - ple data file CTtestl.CG1. All of these procedures will be accomplished during the set-up procedure 

- _- 
Backup 'Disks 

- -  - . .. , -- i 
- --- 1t isrecommended that the original disks be kept as a backup set and stored in a safe location, and that work 

disk$ be made from them. In Windows 95, run Windows Explorer, double-click "My Computer", single-click ., , 

'..,: .- 'icon for your floppy drive, and select "Copy Disk" from the File menu. 

Installation 

The following procedure will install CTGROWTH fiom the floppy drive onto the working directory of the hard 
disk (e.g., copy from A: floppy drive onto hard drive directory C:\MEI\CTGROWTH). 

1. Choose Run ... from the Start menu. Then type "A:SETUP." 

2. Follow the on-screen instructions. 

After set up, a new folder ("ME1 Applications") may be created (depending on your choice during installation) 
with the shortcut to CTGROWTH and other ME1 programs. 

Note: To move other previously installed ME1 applications into this folder, select Start  + Settings + 

Taskbar ... +Star t  Menu + Prognms +Advanced. Then double-click "Programs" to display the folders 
in your Programs menu. Drag and drop shortcuts to other ME1 programs into the ME1 Applications folder. 

O 1998 Maurer Engineering Inc. 



Chapter 2. Getting Started 

2.3 UNINSTALLING CTGROWTH 

Should it ever be necessary to remove CTGROWTH from your computer, access the Windows AddlRemove 
Programs feature (rather than simply deleting the CTGROWTH folder). This feature is activated by running 

Start + Settings + Control Panel + AddlRemove Programs and selecting CTGROWTH from the list of 
programs currently installed on your computer. 

Using this procedure clears the library registq in the Windows system folder and erases the corresponding 
library files that are not stored in the CTGROWTH directory. 

2.4 RUNNING CTGROWTH 

To launch CTGROWTH, 

it from the ME1 
cations program group 
the Program Menu (or 
program group you 

esign and operation of 
input windows in 

ROWTH are described in 
pter 3. Output windows 

features are discussed in 
r 4. For assistance with 

program, contact ME1 
g information presented in 

, -,.,.:. 
pter 5. Common problems 

and solutions are described in 
Appendix A. 

2.5 QUICK TOUR OF CTGROWTH 

The following quick tour will give the new user a rapid overview of the basic structure, features and functions 
of CTGROWTH version 1. 

Install: 

1. Start Windows 95 

2. Insert CTGROWTH Disk I in drive A: 

3. Choose Run ... from the Start Menu. 

4. Type A:SETUP and press Enter. Follow the on-screen instructions. 

2-2 O 1998 Maurer Engineering Inc. 
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- Run: 

Chapter 2. Getting Started 

5. Launch CTGROWTH. Select CTGROWTH from the ME1 Applications folder under S ta r t  Menu -r 

Programs. 

Input: 

6. In the Main Window, choose "Open File ..." from the File menu (or click bJ ). 
7. From the Project File Open dialog box, select "CTTest.CGln in the file list box, and click OK. 

8. Click the "Full-Scale Cycling" tab. Examine the CT parameters on the page. Click on the drop-down 
boxes and change any parameters desired. 

&. 9... Click [Calculate] on the lower right section of the page (or click the run icon The progress of the .. . 
~ :. . ,,, 

i +.-* calculation will be displayed on the right end of the icon toolbar. 
-. --. ,-. 

- output: 
*. 

10. After the Output Window is opened, an informational text message is displayed within the graph area that 

. - ber of bending cycles the current string can withstand before fatigue failure. Fatigue 
r- 

.failure for this example is predicted to occur after the CT diametral growth reaches 10%; therefore, growth 
will be presented in the output graphs up to 10%. (If fatigue failure is predicted to occur before the CT - reaches lo%, growth will be presented in the output graphs only up to the point of 

1 I .  Review the graph and table in the Output window that display diametral growth per trip into the well. 

. ' - --"12; Click rn to print out the graph and tabulated results. 

4 13. Click [Sensitivity Analysis] or to analyze the sensitivity of diametral growth to changes in tubing OD, 
wall thickness, material grade, pressure and bending radius. 

14. Double-click any graph to enlarge it to full screen. Double-click again to restore the multiple-graph 
display. Click to print a copy of the active graph. 

to return to the Input window. Change any parameter by pulling down the options in the drop- 
down box. Click the run icon to calculate growth based on the new parameters. A 

16. Finally, click to return to the Input window. Click "Exit" from the File menu or l(l in the upper 

right comer of the screen to close the program. 

O 1998 Maurer Engineer ing Inc. 
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-, 3. Input 

3.1 REQUIRED INPUT DATA 

Data input is very simple for modeling CT diamehl  growth. Required data include tubular geometry and 
metallurgy, gooseneck radius and spool diameter (or bending fixture radius), and internal pressure. An option 
is also provided to document any specific project (company name, well description, date, etc.). Documentation 
data will be printed along with any output graphs and tables. 

Project Information: 

1. Project description (company name, project name, well location, etc.) (optional) 

Tubular Data: 
. . - ... ,. . 
:-...:...::.2.1 Tubing OD, wall thickness, material grade (yield strength), and Young's Modulus 

- Cyejlng Parameters: 
. . -..-.- 3." If trips into a well is the reference environment, reel diameter and gooseneck radius are required. If 

cycling is referred to the standard bending test fixture, the bending form radius is required. - e. 
T,, +/e - ,. ---.___,+ 

4. .CT internal pressure. (If an external pressure is present, differential pressure should be used. This would 
rarely be the case since bending normally occurs with the CT exposed to the atmosphere.) 

Data can be entered and displayed in English or metric units, or in a custom combination of units defined by 
i.,, 

. ihe user and stored on disk. 
." z , 

3.2 INPUT WINDOW 

In the Input window of CTGROWTH, there are three different pages for input data. Each is accessed by 
clicking on its tab below the icon tool bar. Functions and parameters on each screen are described in the 
sections which follow. 

O 1998 Maurer Engineering Inc. 



Chapter 3. Input 

3.2.1 Project Page 

:EL::-~. Menu Bar. The function of the pull-down menus in CTGROWTH is similar to that in other Windows 
'*" .~. 

"',,,.,., applications. A description of all functions and features is presented later in this chapter in section 3.2.4. 
.. ,,'~ ;~.;,./'' - , :,, .. <' 
e -- -@ ToolBar. Tool-bar icons can be used to quickly access commonly used functions. The icons are short- 

- - , cuts for menu options. The functions of the icons are: 
"".,,.. ,> 

, ,, , New Project. Clears all input data. . _ ?_ (  ..,. , 

-2 , ",,. . ,?,.% -. ,,..- a Open File. Activates the open file window. 

S a y .  Saves all input data to the current file name. If the project is new, w ~ l l  automatically 
actlvate the Save As ... window. 

Print. Activates the print options window. 

Run. Initiates calculations. Same a s  [Calculate] Progress can be monitored on the Status Bar. 

Output. Goes to output screens without recalculating. Not active if the calculations have not yet 

been performed. 

3 Units. Opens the Units Selection window (see Section 3.2.4). The user can select English, SI, 

or any custom combination of units. 

r/l Help. Opens the Help system for CTGROWTH keyed to the currently displayed wmdow. Same 

as [Fl]. Alternatively, select "Help Topics .." from the Help menu to open Help at the table of 
contents. 

Calculator. Causes the Windows utility calculator to pop up. 
I -- 
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Chapter 3. Input 

@ Page Tabs. Switching between the three input screens for entering or checking data is simple - just click 

on the corresponding tab. 

@ Project File. The project file currently in use is displayed. CTGROWTH files are automatically assigned 

the extension .CGl. 

6) Project Description. These data provide specific information about the project to identify the company, 

project name, well location, date, and miscellaneous comments. This information will be printed in a 

heading block in all printouts of graphs and tables. Any or all of these items may be left blank if desired. 

The function of the program will not be affected. The maximum string length for each entry is 50 
characters. 

@ Calculation Status Bar. After the input data are entered, the calculation is launched by clicking the run 

icon or the [Calculate] button. Prior to beginning the calculations, the program automatically checks --.- -. 

the data for errors. Errors include parameten that are outside the allowable range as specified in Section 

3.3. As the calculations are performed, the ongoing status is displayed in this bar with a percentage - complete ~ndicator 
-- 

- 
.h 

3&2 Bending Fixture Cycling Page 
I __.-- 

L 

o basic options are provided for analyzing CT growth. The first option, Bending Fixture Cycling, is 

- yided for users interested in laboratory analysis of growth, correlation to other laboratory data, etc. Growth 
IS described with direct reference to the standard CT fatigue test fixture (these fixtures are operated by CT 

anufacturers and other companies). The bending radius of the curved form on the test fixture is required 

nput. In addition, results are presented as bending cycles that represent a single bendstraighten cycle as 
. . -measured in the laboratory. 

" "" 

The second option, Full-Scale Cycling (next section), will be preferred by most users. This calculation option 

is based on full-scale rig geometry. Required input includes the reel diameter and the gooseneck radius. 

Output results are presented as bips in and out of the hole. Each bending h-ip represents three bendstraighten 
cycles as is normally considered for field operations (that is, two bend~ng cycles at the gooseneck radius and 

one bending cycle at the reel diameter). 

O 1998 Maurer Engineering Inc. 



Chapter 3. Input 

Paramders. Data describing CT geomeby and material properties are required 

ior to calculation. The most common options are provided for convenience in 
lick on the arrow i 7  to vlew the options provided. Otherwise, 7 '  

$ype in any desired value. The allowable range of values for each parameter is 

defined in Section 3.3. 

ending Radius. Enter the desired bending radius as it applies to the standard CT 

@ Equipment Schematic. Parameters required for calculating diamekal growth and fatigue life are defined 

schematically for the user's reference. 

3.2.3 Full-Scale Cycling Page 

Two priicipal options are provided for analyzing CT growth. The fmt  option, Bending Fixture Cycling (see 

previous section), is provided for users interested in laboratory analysis of growth, correlation to other 
laboratory data, etc. Growth is described with direct reference to the standard CT fatigue test fixture (operated 
by CT manufacturers and other companies). The bending radius of the curved form on the test fixture is 
required input. In addition, results are presented as bending cycles that represent asingle bendstraighten cycle 
as measured in the laboratory. 

The second option, Full-Scale Cycling, will be preferred by most users. This calculation option is based on 
full-scale rig geometry. Required input includes the reel diameter and gooseneck radius. Output results are 
presented as trips in and out of the hole. Each bending trip represents three bendshaighten cycles as is 

normally considered for field operations (that is, two bending cycles at the gooseneck radius and one bending 
cycle at the reel diameter). 
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TParametem. Data describing CT geometry and material properties are required - rc rior to calculation. The most common options are provided for convenience in 

1 .  drop-down lists. Click on the arrow . r to vlew the options provided. Otherwise, 

- type in any desired value. 1 .500 

Bending Radius. Enter the diameter of the CT reel and the radius of the rig 

gooseneck. 2.875 - - 

., -"* 1 3.500 
: ,*a Equipment Schematic. Parameters required for calculating diametral growth and 

fatigue life are defined schematically for the user's reference. 

3.2.4 Input Window Menus 

The menu system used in CTGROWTH is typical of Windows applications. Most functions are self- 
explanatory. There are four menus in the Input window of CTGROWTH: File, Run, Utilities and Help. 

File Menu 

The File menu contains commands for creating, retrieving, saving and printing input 
data. The functions of the individual menu options are: 

1. "New" clears the Project page. CT parametric data are not affected. 

2. "Open...'' opens a dialog box for exploring the file system for input files with the 
extension ".CGI ." 
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3. "Save" replaces the previous version of the input data file with the current modified data. No prompt is 

given before overwriting the previous version of the file. 

4. "Save As ..." saves the current version of the input data under a different name. A dialog box is opened 
to let the user specify the drive, directory, and name of the project file. 

5. "Print" prints a form displaying all current input data and parameters 

6 .  "Exit" concludes the current session. CTGROWTH will prompt for saving the project file if data have 

been changed and not yet saved. 

Run Menu 

The Bun menu is used to launch CTGROWTH calculations. Click 

"Start" after all input data are entered. CTGROWTH will check for 

emors in the data (e.g., parameters outside the allowable range (see Section 3.3), internal pressure greater than ... ' " ,$ , , # , A  ,&a,, 

.--,-, -burst pressure ratings, etc.) prior to performing the calculations. The [Calculate] button or the run icon 

.: can,also be used to launch the calculations. 
, , . .,,." 

The Calculation Status Bar (located on the right end of the icon tool bar) will display the progress of the 
- " - -  

'z -..-- calculation (from 0 to 100% complete). After the calculations are completed, the Output window displaying 

the results will be loaded automatically. . > .- I x. '. 

*---, 

-Thk~t i~ i t ies  menu includes: 

"Units ..." opens the Units selection window (see below). Same as 4 
.  calculator" opens the Windows utility calculator. Same as a. 
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Units Selection Window 

- 
F .Units Table. Physical parameters and currently assigned units for each quantity are displayed in the Units 

Table. The user cannot edit this table directly (indicated by the yellow background). Allowable options 

- _-.- for each quantity are accessed by pulling down the drop-down box attached to each quantity. 

Custom Unit3 ControlBuftons. If any changes are made to the default English or S1 systems of units by 

electing another option fiom one or more pulldown boxes, the new custom system will need to be saved 

future use. Use the [Save] button for new custom systems or updates to previously created systems. 
e [Save As ...I button is used when a new combination of units is designed, and the user wishes to save 

it separately, rather than overwriting the previous custom system. Both save buttons will cause a save 

dialog box to pop up. Custom systems of units are stored as *.LINT files. 

The [Print] button will print the Units Selection Table for documentation or reference. (This functions 

only after a save.) 

@ System of Units Selection Buftons. These buttons select entire systems of units, which then appear in the 

table, and in CTGROWTH screens and graphs. The [Other] button will display the file names of the 

custom systems previously created and stored. 

The name of the currently selected system of units is displayed in the upper left comer of the Units 
Selection Window ("Default English" in the figure above). 
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@ Numeric Display Format Table. The number of digits displayed for each parameter can be adjusted by 

the user. The number of zeroes after the decimal point for each quantity will be used as standard for the 
input entries and for printouts. 

Within the decimal section of the number (which defines how many decimals are displayed), a zero 
denotes a "hard" digit (always displayed) and a "#" denotes a "soft" digit (displayed if required). 

@ Control Buttons. These buttons control operations for the entire Units Selection window. [OK] accepts 

the current settings after any changes are made and then returns to the previous window. [Cancel] ignores 
any changes made since this Units window was activated and retums to the previous window. [Undo All] 
deletes all changes made since this Units window was activated, but stays in the Units window for further 
editing. 

Ip menu provides assistance for running CTGROWTH and presents 
-. .-wafious parameters describing the user's computer. 

=t "Help Topics ..." launches the CTGROWTH Help system from the Table 
**- -- - 

of Contents. Alternatively, clicking or presslng [Fl] opens the Help _ --. 
tl 

system directly on a description of the current screen. 

'2: "Assistance ..." opens a pop-up box which displays MEI's address, phone 
-- "-.-,- number, e-mall address and other information. Use these contacts to 

obtain additional help with CTGROWTH. 

- 3 "About. ."opens the About pop-up box, which displays the version number of CTGROWTH along wlth 

hardware in the user's computer. Click "Licensing ..." to view a summary of the restrictions for copying 
the program and manual, and the program disclaimer. 

4. "Feedback ..." opens a special screen form for documenting specific bugs, problems, etc. and 
communicating with MEI. The form can be printed for faxing or saved to disk and attached to an e-mail 
routed to mei@maureng.com 
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- 3.3 PARAMETER LIMITS 

CTGROWTH was developed based on Halliburton's growth model (which was itself based on full-scale test 
data for large CT 2-inch and above) and laboratory data from Precision Tube Technology for CT less than 2 
inches. The model was also calibrated by comparison with a wide range of test data from Quality Tubing. For 
more discussion on the theoretical background, see "Theoretical Basis" in Section 1 .I. 

Limits are set within CTGROWTH for each of the input parameters. These limits are set by the program to 
avoid extrapolating the results to configurations significantly outside the range for which experimental data 

were available. 

The maximum and minimum allowable values for each parameter are listed in the table. 

CT OD (in.1mm) 

Wall Thickness (in./mm) 

11 Internal Pressure (psi/kPa) 1 1,000 1 6,895 1 7,000 148,265 11 

Young's Modulus (psi/kPa) 

Yield Strength (psi/kPa) 

0.75 / 19.1 

0.08 12.03 

3.50 188.9 

0.250 15.72 

18.5 x 10'1 128 x 10' 

70,000 1482,650 

-- .* 

- 
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35 x 106/241 x lo6 

100,000 1689,500 

* - 
b 

Reel D~ameter (in.1mm) 

Gooseneck Radius (in.1mm) 

Bendlng Form Radius (in./mm) 

48 I 1,219 

72 I 1,829 

240 16,096 

180 14,572 

I 481 1,219 120 13,048 
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4. Output 

4.1 MAIN OUTPUT WINDOW 

CTGROWTH diametral growth calculations are summarized in the Main Output window. Presentation formats 
include a graph and a table. The uppermost value presented is based on the more restrictive of two limits. The 
primary limit is that growth is nor allowed ro exceed 10% of nominal OD. Many operators and service 
companies impose a limit of about 6% on CT growth based on equipment constraints (i.e., fitting the CT 

through the gripper blocks and stripper). Based on these considerations, CT growth of 10% was chosen as a 
practical upper limit for all analyses. Experimental data above 10% were also excluded from the correlations 
to allow a closer fit to data in the range of interest (0-10%). 

The second limit applied to the output data presentations is fatigue failure. If the CT is predicted to fail from 

fatigue before the diameter grows by lo%, then growth is shown only up to the porn1 offatigue failure. 
" - 

4.1.1 Output Graph and Table 

@ Menu Bar. The pull-down menus in CTGROWTH output are used to modify output presentation, export 

data, select options for graph design, and several other useful functions. A description of functions and 
features of the output menus is presented in Section 4.1.2. 

@ ToolBar. Tool-bar icons can be used to quickly access commonly used functions from the menus. The 

functions of CTGROWTH's output window icons are: 
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Pr~nt. Prints the current graph and table. 

leJ Save. Saveshe current graph and table to disk in metafile format. 

CZJ Input Wlndow. Returns to the Input window for reviewing andor editing input data. 

Sens1tlvgy Analysis. Opens the Sensitivity Analysis window. See Section 4.2. 

El Help. Launches the CTGROWTH Help system keyed to the current screen. Same as [Fl] 

Calculator. Pops up the Windows utility calculator. 

@ Graph of CT Growth. Results 

of calculations for the current 

input parameters are displayed 
graphically. If the calculation 

as launched from the Bending 

Fixture Cycling page (see 
Section 3.2.2), the x-axis 

arameter will be cycles (one 
endtskaighten sequence). If the 
alculation was launched from 

e Full-Scale Cycling page (see 

ection 3.2.3), the x-axis will be 
trips (one complete trip inlout of 

*the hole consisting of three bendstraighten sequences). 

e maximum y-axis value is set based on the fatigue limit or the growth criterion of 10%. If fatigue 

failure is predicted to occur after the CT diametral growth reaches lo%, growth will be presented in the 

utput graphs only up to 10%. If fatigue failure is predicted to occur before the CT diametral growth 
reaches lo%, growth will be presented in the output graphs only up to the point of fatigue failure. 

CT Diametral Growth 
/00.tllelYl".,,,.,r.o,~I", 

0 5 10 15 20 I5 3D 

-dl- 

@ Table ofCT Growth. Tabulated output fiom CTGROWTH is presented for evaluation. If the calculation 

was launched from the Bending Fixture Cycling page (see Section 3.2.2), the independent parameter will 

by cycles (one bendstraighten sequence). If the calculation was launched from the Full-Scale Cycling 
page (see Section 3.2.3), the first column will be trips (one complete trip inlout of the hole consisting of 

three bendshaighten sequences). 

CT Diametral Growth 
,00.>mhlYlh.bru-ols*> 

IlV-Llh- 

- - 
t 

Fatigue Limited 

D 5 10 I5 20 

lbsR.wdPW 

4.1.2 Output Window Menus 

The menu system design used in CTGROWTH is similar to other Windows applications. Several of the most 
commonly used menu functions can be easily accessed through the tool bar icons (see previous section). There 

are three menus in the Main Output window of CTGROWTH: rile, Sensitivity, and yelp.  
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directory, and the name of the image file (extension .out). 

The table is written to disk in ASCII format with space delimiters. 
- -.a""" 

3:  "Copy Graph to Clipboard" copies the output graph to the Clipboard in metafile (*.WMF) format. 

_ -9. "Pr~nt Graph" prints a high-quality image of the main output graph at the full resolution of the printer. 
CTGROWTH offers the option of printing in color. After a print job is launched, a second box will pop 

--.----.-,up for selecting a color printer. 

- . . .., .., Szi;. .?''Print Report" prints a complete summary of the output data including input data, a graph of CT growth 
-. .- /"-* -*_ 

.,, _1 with bending cycles, and a table of results. 
,.,:.% >,. 

. , ,- ' 6  "Retum" is used to transfer back to the Input window for reviewing or modifying input data. If, after 
-'.\-. 

-.reviewing input data, you wish to return to the Output window without making any changes to the input 

,.;,,i., ,~ data, click the Icon. This saves time by not launching the calculation sequence if no data were ".. , ,+ H' 
, . 
- changed. 

, t 
, .... . 

sensitivity Menu 

The Sensitivity menu is used to launch the Sensitivity Analysis window for analyzing 

the impact of changes in all critical parameters (see Section 4.2). Same as a. 

Help Menu 

The Help menu provides assistance for running CTGROWTH. "Help 
Topics ..." launches the CTGROWTH Help system from the Table of 

XI Contents. Alternatively, clicking or pressing [Fl] opens the Help 

system directly on a description of the current screen. 
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4.2 SENSITIVITY ANALYSIS WINDOW 

Sens%irity to Wall I S e n s M y  lo Ouisida S e n s Y i  to tntemal 
Thickness (m) Oameter (m) 

ensitivity Analysis window is used for evaluating the effects on CT growth of relatively small changes 

bing OD, wall thickness, material grade, internal pressure, and bending radius. These analyses will 
cate the parameters that have the largest influence on CT growth as well as the most efficient approach(es) 

creasing growth. This window is accessed by clicking [Sensitivity Analysis] at the bottom of the main 
t window or the @ icon. 

- @ Sensitivity Graph Windows. The results of the sensitivity analyses are presented for review and 
,: . . 

. . . . .. , comparison in six tiled subwindows. Double-click on any graph to enlarge it to full screen. The windows 
.' , ->-::,*,''- 

include: 

1. Wall Thickness. CT growth for the current wall thickness is compared to CT growth with wall 
thickness 0.007 inches above and below the selected thickness (same nominal CT OD). 

2. Internal Pressure. CT growth with the current internal pressure is compared to CT growth with 1000 
psi above and below the current pressure. When the selected input pressure is less than 2000 psi, the 
lower bounding curve will not be displayed because the model is based on test data from 1000 to 7000 
psi. The same applies to input pressures above 6000 psi, for which case no upper bounding curve is 
displayed. 

3. YieldSh-ength. The impact of material yield strength is shown for three strengths: the current yield, 
and 10,000 psi above and below the current yield. 

4. OD. The selected CT OD is shown along with ODs 0.25 inches smaller and larger (with the same wall 
thickness). 

5. Bending Radius. The current bending radius (either the bending form radius for bending fixture cycle 
calculations, or the gooseneck radius and reel diameter for full-scale trip calculations) is compared 
to radii 14 inches (356 mm) above and below the current radius. 

4-4 0 1998 Maurer Engineering Inc. 



5. Getting Help 

5.1 CONTACTING ME1 

For additional assistance with operation or application of CTGROWTH, contact: 

Telephone: (713) 683-8227 
Fax: (713) 683-6418 

E-mail: mei@maureng.com 

I 

- - S Z S P O R T I N G  PROBLEMS 

Dr. Steve Yang or Chad Gao 
Maurer Engineering Inc. 

2916 West T.C. Jester Boulevard 
Houston, Texas 77018-7098 U.S.A. 

..,, ".. ' . ,:,-?TGROWTH version I has been carefully checked before its release; however, software bugs are a fact of life. 
-- --- M e  report any bugs you fmd and describe the input parameters and conditions selected when the problem 

"..occurred. Please check Appendix Ajirst to determine whether the solution to your problem is described there. 
, .,: -i. -, ., *.,, 

. ,. . 
ml is also very appreciative of your comments and suggestions for improving CTGROWTH. Let us know 
,if there are additional features you would like to see added to the program. Though it may not be feasible to 

";. sircorporate every suggestion into the next version, many important improvements have been made to ME1 
programs based directly on suggestions from users. 

Please use the form on the next page to report bugs in the program, as well as suggestions on improving the 
function and usefulness of CTGROWTH. 
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Bug Reportmnhancement Suggestion Form 

Name: Company: 
Address: City: State: 
Phone No.: Fax No.: 
E-mail: Date: 

BugProblem Report Enhancement Suggestion 

Program Name and Version Number: 

Bug/Problem Description or Suggested Enhancement: 

- - 
Other Comments: 

Dataparameters Causing Bug 
Will be mailed on diskette Will be faxed Attached None 

Ooerating Svstem 
MS-DOS Version No.: MS-Windows Version No.: (Win 3.1lWin 95) 

OS2 MS-Windows NT Version No.: 
Other 

Please mail, fax, or e-mail to: 

Mr. Lee Chu 
MAURER ENGINEERING INC. 

2916 West T.C. Jester 
Houston, TX 77018-7098 

Ph: 7131683-8227 Fax: 7131683-6418 
E-mail: mei@maureng.com 
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A ~ ~ e n d i x  A - Common Problems and Solutions 

Specific problems related to installing and running ME1 software are described in this section. These problems 
have been reported by multiple users and are often related to computer settings and file locations. 

A.l INTERNATIONAL KEYBOARD SETTINGS 

"Type Mismatch" Error 

All computer software developed at Maurer Engineering Inc. is written usingthe U.S. Keyboard format. Under 
this numeric standard, the 1000 separator is a comma, and the decimal separator is a period. Thus, the number 
one thousand, two hundred and thirty-four and 22llOO is written as 

Numbers input into ME1 programs are stored in this format, 
-" ," .- .-I 

ems have occurred for some of our clients who use the lntemational Keyboard format, as is common in 
-in countries in Europe and South America. Here, the same number would be written 

g 1.234,22 

e the 1000 separator is a period, and the decimal separator is a comma. 
8 -  _ , _  - 

9 "-. F- wlth the International Keyboard format fmd that their computers garble input data being loaded into ME1 - 
I." 

'.-.,programs. Often, a "Type Mismatch" error halts the program. .I -~ .. . - , '. *.' 
," . .. 

C 

, -  This problem can be readily solved by changing the Windows numbers format from lntemational to U.S. -'--.. > 

format. This can be accomplished as follows: 

. Select the "Control Panel" icon 6om the Main menu screen. This is done by pointing the mouse to this 
icon and double clicking. This brings up the "Control Panel" menu screen, as shown below. 
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A.3 PRINTER SELECTION 

ME1 programs support a wide range of monochrome and color printew. However, most programs written in 
Visual Basic 3 (16-bit) do not provide options within the program for selecting individual printers. All print 
jobs are sent to the current Windows default printer. 

Changing Printers 

If you wish to switch to a special printer, assign that printer as the Windows default printer before 
running the ME1 program. The default printer is selected under the Printers control window. This window 
is accessed in Windows 95 by selecting Start + "Settings" -+ "Printers". After the Printers window is open, 
click once on the printer of interest to highlight it. Then, select "Set as Default" from the File menu. 

Network Printers 

users have experienced problems when trying to send output from ME1 software to network printers. 
difficulties can be addressed by modifymg the printer port entry. If a network printer will not print from 

.. ari:'WEI program, follow these steps: 

Select Start + "Settings" -+ "Printers"; then double-click the network printer icon. -- -- - 
2. Select "Properties" from the Erinter menu. Select the "Details" tab from the Properties window (see 

Pi.& --"-" - "------- figure) 
-. -. : a Place the cursor on the entry in the text box under Print to the following port:. Copy the text string by - - ' **** 

- 2  ,," ~ressing control+C. 

Click the "Capture Printer Po rt..." button. 1 
Select "LPR" or "LPT3" under the Device 
pull-down menu. I 
Click the Path: text box; then paste the text 
string into the box by pressing control+ V. 

Click <OK> to close the "Capture Printer, 
Port" window. 

On the "Details" window, pull down the list 3 

of options under the Print to the following{ 
port: box. Select the new entry (that you 1 
just created) with "LPT2" or "LPT3" f 
followed by the text string copied and { 
pasted. 

j 

Select <OK> and close all printer windows. ! 

This procedure should allow printing to a 
network printer, provided that printer is 
also selected as the Windows defaulti 
printer. 
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